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快速入门

创建 SQL Server 实例
最近更新时间：2024-01-16 17:40:53

操作场景

本文为您介绍通过云数据库 SQL Server 控制台创建实例的操作。

前提条件

已 注册腾讯云 账号，并 实名认证。

操作步骤

创建实例

1. 登录 SQL Server 购买页，依次完成选择基础配置、设置网络和数据库、确认配置信息步骤，阅读并同意服务条

款，确认无误后，单击立即购买。

步骤一：选择基础配置

在选择基础配置步骤中，您可设置实例的基础配置和规格配置项，具体设置项如下：

基础配置

计费模式：支持按量计费。

地域：选择实例部署的地域，为了降低访问时延、提高下载速度，建议您选择最靠近您客户的地域。

可用区：选择所选地域内的可用区，支持选择随机可用区，系统随机分配。

实例架构：支持单节点和双节点。

存储类型：

选择单节点架构时，存储类型支持选择高性能云盘、SSD 云硬盘、通用型 SSD 云硬盘、增强型 SSD 云硬盘。
说明：

国内地区，单节点实例如有 SSD 云硬盘磁盘类型的业务需要，请 提交工单 申请。
选择双节点架构时，存储类型支持选择增强型 SSD 云硬盘、通用型 SSD 云硬盘、高性能本地 SSD。

 详细了解各存储类型的说明和适用场景，请参见 存储类型。
数据库版本：支持 SQL Server 2008 R2，SQL Server 2012、SQL Server 2014、SQL Server 2016、SQL Server 
2017、SQL Server 2019 Enterprise 和 Standard 版本，支持 SQL Server 2022 Enterprise。

规格配置

https://www.tencentcloud.com/document/product/378/17985
https://www.tencentcloud.com/document/product/378/3629
https://buy.tencentcloud.com/sqlserver#/
https://console.tencentcloud.com/workorder/category
https://www.tencentcloud.com/document/product/238/46490
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类型：支持独享型。

筛选：快捷筛选所需实例的 CPU 和内存，默认选中全部 CPU、全部内存。
已选实例：显示已选实例的规格信息，包括规格类型及规格。

实例规格：显示实例的规格类型、CPU、内存、最大 IOPS、支持可用区、规则参考费用。
存储空间：选择所需磁盘容量。

步骤二：设置网络和数据库

网络：支持私有网络，连通性检测请参见 网络环境，VPC 网络和子网均支持模糊搜索。
说明：

建议云服务器和云数据库是在同一账号，且同一个私有网络内（保障同一个地域，不限可用区）。

子网是私有网络的一个网络空间，为逻辑概念，同一私有网络下可以创建不同可用区的子网，同一私有网络下不同

可用区的子网默认可以内网互通，即使您选择同地域下其他可用区的子网，实际业务连接访问为就近逻辑，也不会

增加网络时延。

安全组：一种有状态的包含过滤功能的虚拟防火墙，用于设置单台或多台云数据库的网络访问控制，是腾讯云提供

的重要的网络安全隔离手段。

说明：

支持新建安全组或者选择已有安全组，支持多选和模糊搜索。

实例名：支持立即为实例命名或者创建后再命名。

多可用区部署：选择是，表示设置多可用区部署，需在下一步选择备可用区。选择否，表示不进行多可用区部署。

多可用区是在单可用区的级别上，将同一地域的多个单可用区组合成的物理区域，可保护数据库，以防数据库实例

发生故障或可用区中断。

备可用区：选择多可用区部署后，需要选择备可用区，具体以实际可选资源为准。

系统时区：默认支持 China Standard Time（北京时间）。
若购买双节点本地盘实例，要修改系统时区需先 提交工单 申请。
若购买单节点云盘或双节点云盘实例，则无需申请，可直接修改。

字符集排序规则：实例字符集为系统数据提供排序规则，即区分大小写属性和重音属性。默认支持 
Chinese_PRC_CI_AS。
若购买双节点本地盘实例，要修改字符集规则需先 提交工单 申请。
若购买单节点云盘或双节点云盘实例，则无需申请，可直接修改。

所属项目：云数据库 SQL Server 支持将实例分配至不同的项目进行管理，支持模糊搜索项目名称更快选取项目。
标签：便于分类管理实例资源。支持添加多个标签。

维护周期和维护时间：为保证云数据库 SQL Server 实例的稳定性，后台系统会不定期在维护时间内对实例进行维护
操作。建议对业务实例设置自己可接受的维护时间，一般设置在业务低峰期，将对业务的影响降到最低，维护周期

最多支持选择7个。
步骤三：确认配置信息

显示步骤一、步骤二的实例配置详情，如需修改，可直接单击编辑，确认无误后阅读勾选服务条款，单击立即购

买。

服务条款：详细可参见 服务条款。

2. 购买后返回 实例列表，查看创建的实例，待运行状态显示为运行中，表示实例创建成功。

https://www.tencentcloud.com/document/product/238/32562
https://console.tencentcloud.com/workorder/category
https://console.tencentcloud.com/workorder/category
https://www.tencentcloud.com/document/product/238/35546
https://console.tencentcloud.com/sqlserver#/
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创建账号

1. 在 实例列表，单击实例 ID 或操作列的管理，进入实例管理页面。

2. 在实例管理页面，选择账号管理 > 创建账号，在弹出的对话框填写相关信息，确认无误后单击确定。
说明：

此账号名和密码在连接 SQL Server 云数据库时使用，请妥善保管。

创建数据库

1. 在 实例列表，单击实例 ID 或操作列的管理，进入实例管理页面。
2. 在实例管理页面，选择数据库管理 > 创建数据库，在弹出的对话框填写相关信息，确认无误后单击确定。

数据库名称：由字母、数字、下划线组成，字母开头，最长32个字符。
支持字符集：选择该库采用的字符集，目前已支持大多数原生字符集。

授权账号：可以针对已有账号对该库进行授权，如未创建账号，可参见 创建账号。
备注说明：输入备注说明，最多256个字符。


https://console.tencentcloud.com/sqlserver
https://console.tencentcloud.com/sqlserver
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连接 SQL Server 实例
连接实例场景
最近更新时间：2024-01-16 17:40:53

本文介绍在 Windows 云服务器中或 Windows 本地通过 SQL Server Management Studio（SSMS）连接到 SQL 
Server 实例的几种场景及连接方式，具体操作步骤详见 从 Windows 云服务器连接 SQL Server 实例、从本地连接 
SQL Server 实例。

从 Windows 云服务器 CVM 连接云数据库 SQL Server

场景一

CVM 和 SQL Server 属于同一个腾讯云主账号，位于同一个地域，网络类型都是 VPC 且处于同一个 VPC 内或网络
类型都是基础网络。

举例：例如账号1下，广州 VPC1 中的子网 A 下的 CVM 和 账号1下，广州 VPC1 中的子网 B 下的 SQL Server。

连接方式：通过内网连接。

场景二

CVM 和 SQL Server 属于同一个腾讯云主账号，位于同一个地域，但处于不同 VPC 内。


举例：例如账号1下，广州 VPC1 中的子网 A 下的 CVM 和广州 VPC2 中的子网 B 下的 SQL Server。

连接方式：推荐通过 云联网 连接。

场景三

CVM 和 SQL Server 属于同一个腾讯云主账号，但位于不同地域。

举例：例如账号1下，广州 VPC1 中的子网 A 下的 CVM 和北京 VPC2 中的子网 B 下的 SQL Server。

连接方式：推荐通过 云联网 连接。

场景四

CVM 和 SQL Server 属于腾讯云不同主账号。


举例：例如账号1下，广州 VPC1 中的子网 A 和账号2下，北京 VPC2 中的子网 B。

连接方式：推荐通过 云联网 连接。

从 Windows 本地连接云数据库 SQL Server

双节点（原高可用版/集群版）实例连接方式

https://www.tencentcloud.com/document/product/238/11626
https://www.tencentcloud.com/document/product/238/11627
https://www.tencentcloud.com/document/product/1003/31985
https://www.tencentcloud.com/document/product/1003/31985
https://www.tencentcloud.com/document/product/1003/31985
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方案1：通过 VPN 或 专线 或 云联网 连接，更安全更稳定。
方案2：通过外网连接，可在控制台 开启外网地址 或 绑定 CLB 开启外网服务。
方案3：借助 具有外网 IP 的 Linux 云服务器进行端口映射。

单节点（原基础版）实例连接方式

方案1：通过 VPN 或 专线 或 云联网 连接，更安全更稳定。
方案2：通过外网连接，可在控制台 开启外网地址。
方案3：借助 具有外网 IP 的 Linux 云服务器进行端口映射。

https://www.tencentcloud.com/document/product/1037/32679
https://www.tencentcloud.com/document/product/216/7557
https://www.tencentcloud.com/document/product/1003/31985
https://www.tencentcloud.com/document/product/238/11627#kqwwdz
https://www.tencentcloud.com/document/product/238/11627#CLBKQWW
https://www.tencentcloud.com/document/product/238/11627#WWIPLJSL
https://www.tencentcloud.com/document/product/1037/32679
https://www.tencentcloud.com/document/product/216/7557
https://www.tencentcloud.com/document/product/1003/31985
https://www.tencentcloud.com/document/product/238/11627#kqwwdz
https://www.tencentcloud.com/document/product/238/11627#WWIPLJSL
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从 Windows 云服务器连接 SQL Server 实例
最近更新时间：2024-01-16 17:40:53

操作场景

本文介绍在 Windows 云服务器中通过 SQL Server Management Studio（SSMS）连接到 SQL Server 实例，并运行
简单查询的操作。

说明：

建议云服务器和云数据库是在同一账号，且同一个 VPC 内（保障同一个地域，不限可用区）。
处于相同地域，且在同一个 VPC 时，不同可用区间云服务器和云数据库可直接通过内网 IP 互通。
处于不同地域、不同 VPC 或跨账号时，也可通过 对等连接/云联网  互通。

操作步骤

1. 登录 SQL Server 控制台，单击实例 ID 进入实例详情页，查看实例内网 IP 及端口号。该内网 IP 及端口号会在连
接云数据库时使用。

2. 登录腾讯云 Windows 云服务器，请参见 快速入门 Windows 云服务器。本文以 Windows Server 2012 R2 标准版
64位中文版为例。
3. 在 Windows 云服务器中下载并安装 SQL Server Management Studio。SQL Server Management Studio 相关介绍
请参见 使用 SQL Server Management Studio。
4. Windows 云服务器上启动 SQL Server Management Studio。在 Connect to server 页面，填写相关信息连接云数

据库。单击 Connect，稍等几分钟后，SQL Server Management Studio 将连接到您的数据库实例。
Server type：选择 Database Engine。

https://www.tencentcloud.com/document/product/553/18836
https://www.tencentcloud.com/document/product/1003/31985
https://console.tencentcloud.com/sqlserver
https://www.tencentcloud.com/document/product/213/10516
https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms
https://docs.microsoft.com/en-us/sql/ssms/sql-server-management-studio-ssms?view=sql-server-ver15
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Server name：数据库实例的内网 IP 和端口号，需用英文逗号隔开。例如，内网 IP 为  10.10.10.10 、端口号

为  1433 ，则在此填入  10.10.10.10,1433 。注意使用英文标点符号。

Authentication：选择 SQL Server Authentication。

Login 和 Password：在实例账号管理页创建账号时，填写的账号名和密码。


5. 连接到数据库后，可以查看到 SQL Server 的标准内置系统数据库（master、model、msdb 和 tempdb）。
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6. 您可以开始创建自己的数据库并对数据库运行查询。选择 File > New > Query with Current Connection，键入
以下 SQL 查询：
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select @@VERSION

运行查询，SQL Server Management Studio 会返回 SQL Server 版的腾讯云云数据库实例。
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从本地连接 SQL Server 实例
最近更新时间：2024-01-16 17:40:53

本文介绍在 Windows 本地通过 SQL Server Management Studio（SSMS）连接到 SQL Server 实例，并运行简单查
询的操作。

连接场景

根据云上数据库实例类型的不同，连接方式也有所差异：

若从本地连接云上双节点（原高可用版/集群版） SQL Server 实例，可通过以下3种方案进行连接。
方案1：通过 VPN 或 专线 或 云联网 连接，更安全更稳定。
方案2：通过外网连接，可在控制台 开启外网地址 或 绑定 CLB 开启外网服务。
方案3：借助 具有外网 IP 的 Linux 云服务器进行端口映射。
若从本地连接单节点（原基础版） SQL Server 实例，可通过以下3种方案进行连接。

方案1：通过 VPN 或 专线 或 云联网 连接，更安全更稳定。
方案2：通过外网连接，可在控制台 开启外网地址。
方案3：借助 具有外网 IP 的 Linux 云服务器进行端口映射。
下文分别介绍如下连接方案：

通过控制台开启外网地址，在本地通过 SSMS 连接到 SQL Server 实例。
通过绑定 CLB 开启外网服务，在本地通过 SSMS 连接到 SQL Server 实例。

借助具有外网 IP 的 Linux 云服务器进行端口映射，在本地通过 SSMS 连接到 SQL Server 实例。

通过控制台开启外网地址在本地通过 SSMS 连接到 SQL Server 实
例

步骤1：开启外网地址

1. 登录 SQL Server 控制台。
2. 选择地域，在实例列表单击需要开启外网的实例 ID 或操作列的管理。
3. 在实例详情页的基本信息 > 外网地址后，单击开通。
4. 在开通外网设置窗口阅读并勾选提示，单击确定。

5. 开通成功后，在实例详情页基本信息下查询实例的外网 IP 地址和端口号。
说明：

关于开启外网详细的注意事项和步骤，可参见 开启外网地址。

步骤2：通过外网连接 SQL Server 实例

https://www.tencentcloud.com/document/product/1037/32679
https://www.tencentcloud.com/document/product/216/7557
https://www.tencentcloud.com/document/product/1003/31985
https://www.tencentcloud.com/document/product/1037/32679
https://www.tencentcloud.com/document/product/216/7557
https://www.tencentcloud.com/document/product/1003/31985
https://www.tencentcloud.com/document/product/238/11627
https://console.tencentcloud.com/sqlserver
https://www.tencentcloud.com/document/product/238/50230
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1. 在本地下载并安装 SQL Server Management Studio。SQL Server Management Studio 相关介绍请参见 使用 SQL 
Server Management Studio。
2. 本地启动 SQL Server Management Studio。在 Connect to server  页面，填写相关信息连接云数据库。单击 

Connect，稍等几分钟后，SQL Server Management Studio 将连接到您的数据库实例。
Server type：选择 Database Engine。
Server name：实例的外网 IP 地址和端口号，需用英文逗号隔开。
Authentication：选择 SQL Server Authentication。
Login 和 Password：在实例帐号管理页创建帐号时，填写的帐号名和密码。


3. 连接到数据库后，可以查看到 SQL Server 的标准内置系统数据库（master、model、msdb 和 tempdb）。


https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?view=sql-server-ver16
https://docs.microsoft.com/en/sql/ssms/sql-server-management-studio-ssms?view=sql-server-ver15
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4. 现在您可以开始创建自己的数据库并对数据库运行查询。选择 File > New > Query with Current Connection，
键入以下 SQL 查询：
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select @@VERSION

运行查询，SQL Server Management Studio 会返回 SQL Server 版的腾讯云云数据库实例。
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绑定 CLB 开启外网服务在本地通过 SSMS 连接到 SQL Server 实例

步骤1：新购负载均衡

说明：

如果在云数据库 SQL Server 同地域已经有负载均衡实例，可以不用购买。

进入 负载均衡购买页，选择完配置后单击立即购买。
注意：

地域需选择云数据库 SQL Server 所在的地域。
所属网络，选择和数据库相同的 VPC 或者不同都可以。

步骤2：配置负载均衡

1. 打开跨 VPC 访问功能（如果 CLB 和云数据库 SQL Server 在同一个 VPC 可忽略该步骤）。


a. 登录 负载均衡控制台，选择地域，在实例管理列表，单击实例 ID，进入实例管理页面。


https://buy.tencentcloud.com/clb
https://console.tencentcloud.com/clb/instance
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b. 在基本信息页的后端服务处，单击点击配置。

c. 在弹出的对话框，单击提交即可开启。
2. 配置外网监听端口。


a. 登录 负载均衡控制台，选择地域，在实例管理列表，单击实例 ID，进入实例管理页面。

b. 在实例管理页面，选择监听器管理页，在 TCP/UDP/TCP SSL监听器下方，单击新建。


c. 在弹出的对话框，逐步完成设置，然后单击提交即可完成创建。


https://console.tencentcloud.com/clb/instance
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步骤3：绑定 SQL Server 实例

1. 创建好监听器后，在监听器管理页，单击创建好的监听器，然后单击右侧出现的绑定。


2. 在弹出的对话框，选择目标类型为其他内网IP，输入 SQL Server 实例的 IP 地址和端口，单击确认完成绑定。

注意：

登录的账号必须是标准账号（带宽上移），如无法绑定，请 提交工单 协助处理。

步骤4：配置 SQL Server 安全组

1. 登录 SQL Server 控制台，选择地域，在实例列表，单击实例 ID 或操作列的管理，进入实例管理页面。
2. 在实例管理页面，选择安全组页，单击配置安全组，配置安全组规则为放通全部端口，确认安全组允许外部 IP 访
问，详细配置方法请参见 配置安全组。

步骤5：通过外网连接 SQL Server 实例

1. 在本地下载并安装 SQL Server Management Studio。SQL Server Management Studio 相关介绍请参见 使用 SQL 
Server Management Studio。
2. 本地启动 SQL Server Management Studio。在 Connect to server  页面，填写相关信息连接云数据库。单击 
Connect，稍等几分钟后，SQL Server Management Studio 将连接到您的数据库实例。
Server type：选择 Database Engine。
Server name：CLB 的 IP 地址和端口号，需用英文逗号隔开，例如  10.0.0.1,4000 。

Authentication：选择 SQL Server Authentication。
Login 和 Password：在实例帐号管理页创建帐号时，填写的帐号名和密码。


https://console.tencentcloud.com/workorder/category
https://console.tencentcloud.com/sqlserver
https://www.tencentcloud.com/document/product/238/35789
https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?view=sql-server-ver16
https://docs.microsoft.com/en/sql/ssms/sql-server-management-studio-ssms?view=sql-server-ver15
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3. 连接到数据库后，可以查看到 SQL Server 的标准内置系统数据库（master、model、msdb 和 tempdb）。


4. 现在您可以开始创建自己的数据库并对数据库运行查询。选择 File > New > Query with Current Connection，
键入以下 SQL 查询：
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select @@VERSION

运行查询，SQL Server Management Studio 会返回 SQL Server 版的腾讯云云数据库实例。
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借助具有外网 IP 的 Linux 云服务器进行端口映射在本地通过 SSMS 
连接到 SQL Server 实例

说明：

云服务器和云数据库须是同一账号，且同一个 VPC 内（保障同一个地域，不限可用区）。

考虑到数据安全性，云数据库 SQL Server 尚未开放实例外网 IP，如有需求可以利用 SSH2 的端口映射在外网连接
实例，并对其进行配置和管理。

1. 登录 SQL Server 控制台，在实例详情页查看实例内网 IP 及端口号。该内网 IP 及端口号会在配置端口映射时使
用。

https://console.tencentcloud.com/sqlserver
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2. 准备一台具有外网 IP 的 Linux 云服务器，请参见 快速入门 Linux 云服务器。
3. 在本地使用 SSH 工具（如 SecureCRT 等，本文以 SecureCRT 为例）登录 Linux 云服务器，请参见 登录 Linux 实

例。

4. 在 SecureCRT 菜单栏选择 Options > Session Options，进入会话属性设置。


5. 在会话属性设置页，选择 Connection > Port Forwarding > Add，进入配置端口映射页。


https://www.tencentcloud.com/document/product/213/10517
https://www.tencentcloud.com/document/product/213/5436
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6. 在配置端口映射页，配置对应参数。
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7. 在本地下载并安装 SQL Server Management Studio。SQL Server Management Studio 相关介绍请参见 使用 SQL 
Server Management Studio。

8. 本地启动 SQL Server Management Studio。在 Connect to server  页面，填写相关信息连接云数据库。单击 
Connect，稍等几分钟后，SQL Server Management Studio 将连接到您的数据库实例。
Server type：选择 Database Engine。
Server name：本机 IP 地址和端口号，需用英文逗号隔开，例如  10.0.0.1,4000 。端口号需与第6步中配置的

端口保持一致。

Authentication：选择 SQL Server Authentication。
Login 和 Password：在实例帐号管理页创建帐号时，填写的帐号名和密码。


https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms
https://docs.microsoft.com/en/sql/ssms/sql-server-management-studio-ssms?view=sql-server-ver15


云数据库 SQL Server

版权所有：腾讯云计算（北京）有限责任公司 第28
共33页

9. 连接到数据库后，可以查看到 SQL Server 的标准内置系统数据库（master、model、msdb 和 tempdb）。


10. 现在您可以开始创建自己的数据库并对数据库运行查询。选择 File > New > Query with Current Connection，
键入以下 SQL 查询：
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select @@VERSION

运行查询，SQL Server Management Studio 会返回 SQL Server 版的腾讯云云数据库实例。
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管理 SQL Server 实例
最近更新时间：2024-01-16 17:40:53

实例列表页面

登录 SQL Server 控制台，在实例列表，可查看实例相关信息，以及管理实例。

功能 介绍

重启

在实例列表，勾选需要重启的实例，单击重启对实例进行重启操作，支持批量重启（勾选多个实

例）。 
重启期间，实例将无法正常访问，已有的连接会断掉，请您做好准备，以免造成影响。

重启期间，如果业务写入量很大，会导致重启失败。重启失败后，实例回到重启之前状态，实例仍

可访问。

请确保在业务低峰期重启，保证重启成功率，降低对业务的影响。

续费
在实例列表，勾选需要续费的实例，单击续费对所选实例进行续费，支持批量续费（勾选多个实

例），可选择按年或按月进行续费。

设置自

动续费

在实例列表，勾选需要设置自动续费的实例，单击更多操作 > 设置自动续费，支持批量设置自动续
费（勾选多个实例），单击确定后可在该实例到期后按月自动续费，需确保设备到期时账号余额充

足。

取消自

动续费

在实例列表，勾选需要取消自动续费的实例（实例名称前标记有“续”字样的），选择更多操作 > 取
消自动续费，支持批量取消自动续费（勾选多个实例），单击确定后即可取消自动续费。

编辑标

签

在实例列表上方单击更多操作 > 编辑标签，也可在对应实例操作列选择更多 > 编辑标签，可对实例
进行标签管理，如没有创建过标签可单击标签管理前往新建。

配置调

整

在实例列表，您可以对数据库实例进行配置调整，支持实例升级和容灾方式调整，详细介绍请参见 
调整实例规格。

发布订

阅

在实例列表，对应实例操作列选择更多 > 发布订阅，可通过发布订阅，满足业务的数据复制和同步
需求。

销毁/
退货

在实例列表，选择更多 > 销毁/退货，可以对数据库实例进行销毁/退货，详细介绍请参见 销毁实
例。

https://console.tencentcloud.com/sqlserver
https://www.tencentcloud.com/document/product/238/44352
https://www.tencentcloud.com/document/product/238/35787
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转为包

年包月

对按量计费模式的实例，支持一键转包年包月，在实例列表操作列单击更多 > 转包年包月，选择时
长，阅读规则后单击确定即可完成。

只读实

例

在实例列表，实例操作列单击更多 > 只读实例，可查看对应主实例下的只读实例和配置只读实例 
RO 组，如无只读实例，可在跳转后单击新建，扩展一个或多个只读实例。

实例管理页面

登录 SQL Server 控制台，在实例列表，单击实例 ID 或在操作列的管理，可以进入实例管理页面。您可以查看实例
详情、监控、管理数据库等。

功能 介绍

实例详

情

在实例详情页面，您可以查看和操作数据库的各种信息，包括设置维护信息以及在实例架构图中添

加“只读实例”。

系统监

控

在实例监控页面，您可以查看当前数据库运行的众多核心指标的监控，详细介绍请参见 监控功能 
和 告警功能。

备份恢

复

在实例备份恢复页，您可查询备份恢复历史记录和新建备份恢复任务，备份上传方式支持直接上传

文件和从 COS 下载文件，恢复方式支持全量备份文件，全量备份文件 + 日志文件，全量备份文件 
+ 差异备份。

发布订

阅
在发布订阅页面，您可以创建、删除一个或多个发布订阅链路服务。

安全组 在安全组页面，您可以对数据库进行安全组的配置操作，详细介绍请参见 配置安全组。

帐号管

理

在帐号管理页面，您可以对管理员帐号进行管理，如修改权限、重置密码等，也可以创建帐号、删

除帐号，详细介绍请参见 帐号管理。

数据库

管理
在数据库管理页面，您可以创建、设置权限以及删除数据库，详细介绍请参见 数据库管理。

只读实

例

在只读实例页面，您可以创建一个或多个只读实例，以支持用户的读写分离和一主多从应用场景，

可显著提高用户数据库的读负载能力，详细介绍请参见 只读实例。

https://console.tencentcloud.com/sqlserver
https://www.tencentcloud.com/document/product/238/46503
https://www.tencentcloud.com/document/product/238/46501
https://www.tencentcloud.com/document/product/238/35789
https://www.tencentcloud.com/document/product/238/7521
https://www.tencentcloud.com/document/product/238/35780
https://www.tencentcloud.com/document/product/238/43142
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备份管

理

在备份恢复页面，您可以进行手动创建备份、下载备份、设置定时备份、还原备份以及回档操作，

详细介绍请参见 备份管理。

慢查询

日志
在操作日志页面，您可以下载慢查询日志。

参数配

置

在实例参数配置页，您可查看和修改部分参数，并可查询参数修改历史。详细介绍请参见 设置实例
参数。

https://www.tencentcloud.com/document/product/238/45853
https://www.tencentcloud.com/document/product/238/41609

